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1 Introduction

1.1 Add-onModule RF-STABILITY

The add-on module RF-STABILITY of the main program RFEM performs eigenvalue analyses for
member and surface models to determine critical load factors and eigenvectors (buckling modes).
The critical load factor (critical buckling load factor of the global system) allows you to evaluate the
stability behavior of the structural system. The corresponding eigenvector indicates the region in
the model that is prone to buckling. This analysis also considers solid elements.

RF-STABILITY allows you to analyze several eigenvectors at once. After the calculation, the gov-
erning eigenvectors of the RFEMmodel are listed by the critical load factor. The corresponding
effective lengths and critical loads are required for further stability analyses that need to be carried
out for members in compression.

In the graphical representation of the eigenvectors, you can localize the regions prone to buckling
and take constructive measures regarding the eigenvectors, if necessary. This makes RF-STABILITY
a very useful tool for the analysis of structures prone to buckling, for example, slender beams
and thin-walled shells. Based on the critical load factor, you can evaluate whether the model is
generally prone to buckling (flexural buckling, flexural-torsional buckling aswell as lateral-torsional
buckling and plate buckling for 2D objects). Furthermore, you can apply imperfections under
consideration of eigenvectors and use them for the analysis in RFEM.

Features of RF-STABILITY:

• Determination of several eigenvectors in one calculation run

• Import of axial forces from RFEM load cases or combinations

• Option to take into account favorable effects due to tension

• Option to take into account stiffness modifications from RFEM

• Eigenvalue analysis under consideration of user-defined load increments

• Determination of eigenvectors allowing you to resolve problems of instability

• Powerful solver using different eigenvalue methods with user-defined parameters

• Option to normalize eigenvectors

• Tabular display of the critical load factors and corresponding eigenvectors

• Visualization of eigenvectors including option for animation in the RFEM graphic window

• Printout in RFEM report including automatic update for changes

• Preparation of eigenvectors for the add-on modules RF-IMP, RF-KAPPA, RF-STEEL EC3,
RF-STEEL AISC/AS/BS/CS/GB/IS/NTC-DF/SANS/SIA/SP, RF-ALUMINIUM, and RF-TIMBER Pro

• Data export to MS Excel, OpenOffice Calc, or the CSV file format

We hope you enjoy working with RF-STABILITY.

Your team from DLUBAL SOFTWARE, INC.
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1.2 Using theManual

Topics like installation, graphical user interface, evaluation of results, and printout are described in
detail in the manual of the main program RFEM. The present manual focuses on typical features
of the RF-STABILITY add-on module.

The sequence and structure of the manual follows the input and results windows of the module.
In the text, the buttons are given in square brackets, for example [Edit]. At the same time, they are
pictured on the left. The Expressions that appear in dialog boxes, windows, and menus are set in
italicsmaking the connection between the explanations in the manual and the program clearer.

At the end of the manual, you find the index. If you still cannot find what you are looking for,
check our website https://www.dlubal.com/en, where you can go through the FAQ pages and use
various filter criteria.

1.3 Opening the RF-STABILITYModule

In RFEM, you have the following possibilities to start the add-on module RF-STABILITY.

Menu
To open the add-on module, you can select on the RFEMmenu

Add-onModules → Stability → RF-STABILITY

Figure 1.1: Menu: Add-onModules → Stability → RF-STABILITY



1 Introduction

©DLUBAL SOFTWARE 2014

4

1
Navigator
Alternatively, you can open the add-on module in the Data navigator by clicking

Add-onModules → RF-STABILITY.

Figure 1.2: Data navigator: Add-onModules → RF-STABILITY

Panel
If results from RF-STABILITY are already available in the RFEMmodel, you can also open the design
module from the panel:

First, set the relevant RF-STABILITY case in the load case list of the RFEM toolbar. Then, click the
[Show Results] button to graphically display the eigenvector.

In the panel, you can click [RF-STABILITY] to open the module.

Figure 1.3: Panel button [RF-STABILITY]
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2 Input Data
When you start the add-on module, a new window opens. In this window, a navigator is displayed
on the left that manages the available input and output windows. The drop-down list above the
navigator contains the analysis cases (see Chapter 7.1, page 28).

When you open RF-STABILITY for the first time, the created load cases and combinations are
imported automatically.

To select a module window, click the corresponding entry in the navigator. To go to the previous
or next input window, use the buttons shown on the left. You can also use the function keys to
select the next [F2] or previous [F3] window.

To save the results, click [OK]. Thus, you exit RF-STABILITY and return to the main program. To exit
the module without saving the new data, click [Cancel].

2.1 General Data
In the 1.1 General Datawindow, you select the members, sets of members, and actions that you
want to analyze. It is the only input window of the module.

Figure 2.1: Window 1.1: General Data

General

Figure 2.2: Definition of eigenvectors and axial forces
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Number of smallest (or next) eigenvalues

RF-STABILITY determines the most unfavorable eigenvalues of the model, whose number you
specify in this text box. The upper limit is 1,000 eigenvalues (and thus eigenvectors) – that is, if the
number of degrees of freedom and the RAM allow it.

If negative critical load factors are shown after running the analysis, you should increase the
number of the eigenvectors to be determined. For a small number, it is not possible to hide the
negative eigenvalues in order to show only positive, realistic results. Alternatively, you can use
the ICG (incomplete conjugate gradient) method (see below) to exclude the negative critical load
factors.

Find eigenvectors beyond critical load factor

By using this function, RF-STABILITY can show you only those eigenvectors that exceed a certain
eigenvalue. To do this, select the corresponding check box, and then specify the minimum load
increment f0 in the text box.

Import axial forces, nonlinear actions, and initial deformations from load case /
combination

The list contains all load cases and load combinations of the model. Select an entry. The axial
forces and, if necessary, the stiffnesses of these actions are taken into account when determining
the eigenvector. This load case or this combination should be calculated in RFEM by linear static
analysis without stiffness reductions (material, cross-section, member, surface).

Result combinations are not available in the list, because due to the max/min extreme values they
don't show unambiguous distributions of axial forces.

In addition to the axial forces, the stiffness conditions are also imported from RFEM. This means:
The module imports the structural system after the load case or the load combination is calcu-
lated in RFEM. This system is the starting point of the eigenvalue analysis. In this way, you can
approximately consider nonlinear effects as, for example, failing members, supports, and releases,
or member nonlinearities in the linear eigenvalue analysis in RF-STABILITY.

If no results exist for the load case or load combination, the internal forces are automatically
determined before the RF-STABILITY analysis.

When calculating the eigenvector of a beam structure and the effective lengths, the loading is
of decisive importance, because the buckling values depend not only on the structural model,
but also on the ratio of the axial forces to the total critical buckling load Ncr. Therefore it is rec-
ommended to specify a load case with a full vertical loading (without wind) so that most of the
members are subjected to compressive forces.

Options

Figure 2.3: Options
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Consider favorable effects due to tension

If the check box is selected, the tensile forces in the model are taken into account during the
determination of the eigenvalue. Usually, they stabilize the model.

Activate division also for straight members

For better approximation solutions, it can be necessary to refine themember division, in particular
for tapers and members with elastic foundations.

To adjust the member division, click [Edit]. The FEMesh Settings dialog box from RFEM appears.

Figure 2.4: Dialog box FEMesh Settings
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Activate minimum initial prestress for cables andmembranes

By selecting this check box, cable members and membrane surfaces get a very small prestress
that prevents the failure of these elements before the start of the calculation. In this way, you can
also stabilize the model.

To specify the magnitude and type of the prestress, click [Edit].

Figure 2.5: Dialog box Settings for Cables andMembranes

Activate stiffness modifications from RFEM

This check box controls whether the adjustment factors defined in RFEM for the material, mem-
ber, support, release, and cross-section stiffnesses are taken into account during the eigenvalue
analysis. These factors are described in the corresponding chapters of the RFEMmanual. If you
select this check box, all stiffness factors of the load case or the load combination are used under
consideration of the failure criteria during the calculation in RF-STABILITY.

This control option in RF-STABILITY allows you to apply the stiffness modifications independent
of the settings in RFEM. In this way, you can, for example, calculate the axial forces of a load
combination in RFEM without reduction and then determine the critical loads in RF-STABILITY
with the reduced material, member, and cross-section stiffnesses.

If, however, the stiffness change for the load case or the load combination is active, this check box
is unavailable: In this way, the program ensures that the eigenvalues correspond to the model
assumptions.

If the eigenvalues are determined as “characteristic” properties of themodel, the stiffness changes
need not be considered.

Add initial axial forces from load case / combination

After selecting this check box, you can choose a load case or load combination whose axial forces
youwant to use for an initial deformation. You can use this option to, for example, take into account
the stabilizing effect of another load case (that is, a different one from the load case selected in
the General section above) for the eigenvalue analysis.

Result combinations are also missing in this list, because they don't show unambiguous axial force
distributions.

Calculate eigenvector of unstable model

This function allows you to find modeling errors in your structural system. For models determined
to be unstable, the program runs a load-independent eigenvalue analysis. In the graphical evalua-
tion of the results, you can easily find, for example, unconnected members or members with too
many open degrees of freedom.

However, that function cannot detect calculation terminations due to overloading.

For an example of that function, see this DLUBAL blog: https://www.dlubal.com/blog/7907
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CalculationMethod

Figure 2.6: Method of Calculation

Stability analysis

When using the default setting Eigenvalue analysis, the eigenvectors are determined by the purely
linear method. The properties of nonlinearly acting elements, for example, tension members or
supports with failure criteria, are not taken into account. The stiffnesses of such elements are
applied in the matrix as permanently acting.

The Load increased to structural failure option allows you to take into account all nonlinearities in
the eigenvalue analysis. During the incremental increase of the load, failure criteria and nonlinear
effects of members, supports, releases, materials, etc. are taken into account. The calculation is
run iteratively and, therefore, needs more time. Due to the underlying principle, this procedure
allows you to reliably determine only the lowest eigenvalue.

To specify the iteration parameters, click [Edit].

Figure 2.7: Dialog box Calculation Parameters
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The Calculation Parameters dialog box is described in the RFEMmanual, Chapter 7.3.3. The calcula-
tion is run automatically according to the direct solver method.

If, as shown in Figure 2.7, you specify 10 load increments, the program applies 10 %, then 20 %,
then 30 %, …100 %, 110 % …480 %, etc. of the load: The load is increased in 10 % steps until the
system is determined to be unstable. Thus the critical load factor is found.

The duration of calculation can be reduced by the following settings of the Calculation Parameters
(suggestions in brackets):

• Maximum number of iteration shouldn't be too great (50)

• Number of load increments shouldn't be too fine (5)

• Reactivation of failing members should be deactivated

Eigenvaluemethod

There are different calculation methods available in RF-STABILITY:

• Method by Lanczos

The eigenvalues are determined according to the direct method. In most cases, this algorithm
allows you to reach a quick convergence. Because the Lanczos method is faster than the
subspace method (see below), it is the default option in RF-STABILITY.

For further information, see https://en.wikipedia.org/wiki/Lanczos_algorithm

• Roots of the characteristic polynomial

This method is also based on a direct calculation method. For larger structural systems, this
method can be faster than the Lanczos method. The main advantage of this method is the
precision of higher eigenvalues.

For more information, see https:/en.wikipedia.org/wiki/Characteristic_polynomial

• Subspace iterationmethod

In this method, all eigenvalues are determined in one step. The spectrum of the stiffnessmatrix
has a great influence on the duration of calculation in this method.

The stiffness matrix is stored in the operating memory. As soon as this memory is insufficient,
Windows stores files on the hard drive. This considerably slows down the computer. The
subspace method is therefore not suitable for complex systems.

In the subspace method, negative critical load factors cannot be excluded.

For more information, see https:/en.wikipedia.org/wiki/Krylov_subspace

• ICG iterationmethod

The ICG (Incomplete Conjugate Gradient) iteration method needs little operating memory. Only
those coefficients of the stiffness matrix not equal to zero are saved. A disadvantage is that
the eigenvalues are determined one after the other. The spectrum, however, has no influence
on the calculation duration.

The ICGmethod is suited to analyze very large systems with few eigenvalues. This method also
does not yield any negative critical load factors. The procedure continues until the number of
specified positive eigenvalues is reached.

The ICG method sometimes doesn't find all of the lowest eigenvalues.

For more information, see https:/en.wikipedia.org/wiki/Conjugate_gradient_method
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Type of matrix

With the default option Standard, RF-STABILITY uses the geometric stiffness matrix of the linear
equation system.

The Unit matrix is a quadratic matrix with the value one on the main diagonal. This “mathematic”
approach should be used only for numerical and kinematic analyses. Loads and axial forces are of
no importance when solving the general eigenvalue problem.

The matrix types for eigenvalue solutions are described in more detail in [1], Chapter 7.

Normalization of Eigenvectors

Figure 2.8: Normalization of the Eigenvectors

The eigenvectors can be normalized (“norm one”) differently:

• Maximum displacement |u| = 1

• Maximum global displacement (max from uX, uY, uZ) = 1

• Maximum global deformation (max from uX, uY, uZ, 𝜑X, 𝜑Y, 𝜑Z) = 1

• Maximum value of the product {uj}
T ⋅ [KG] ⋅ {uj} = 1where:

{uj}
T
: Transposed eigenvector

[KG] : Geometric stiffness

{uj} : Eigenvector

Depending on the specification, the greater displacement or deformation represents the reference
value one, to which the other results are scaled.

Setting for Graphic

Figure 2.9: Setting for Graphic

Use this check box to display the torsional rotation of members in the results graphic of the eigen-
vectors (see figure on the left).

By default, only torsional rotations 𝜑x with normalized values greater than 0.2 are displayed. This
ensures a clear representation in the graphic.

Comment
In this text box, you can type user-defined notes describing, for example, the current analysis case.
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3 Calculation

3.1 Check
Before starting the calculation, check if the input data is correct. To do this, click [Check] in the
bottom part of the module.

If the module finds an inconsistency, a warning appears showing the corresponding information.

Figure 3.1: Result of check

3.2 Start Calculation
To start the calculation, click the [Calculation] button.

RF-STABILITY searches for the axial forces to be taken into account in the stability analysis. If no
results are available for the load case or load combination, the RFEM calculation starts to determine
the internal forces.

You can also start the calculation in the RFEM user interface. The To Calculate dialog box (menu
Calculate → To Calculate) lists the add-on module cases as well as load cases and load combina-
tions.

Figure 3.2: Dialog box To Calculate

If the RF-STABILITY cases are missing in the Not Calculated list, select All or Add-onModules in the
drop-down list at the end of the section.
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To transfer the selected RF-STABILITY cases to the list on the right, use the button. Click [OK]
to start the calculation.

To calculate an analysis case directly, use the list in the RFEM toolbar. Select the relevant RF-STA-
BILITY case in the list, and then click [Show Results].

Figure 3.3: Direct calculation of an RF-STABILITY case in RFEM

You then can observe the stability analysis process in a separate dialog box.

Figure 3.4: RF-STABILITY calculation

In the eigenvalue analysis according to one of the direct calculation methods, the so-called Sturm
Sequence Check is run. It checks whether all eigenvalues are found in a certain interval. The
diagonal matrix from the GAUSS decomposition is used, whose number of negative diagonal
elements corresponds to the number of eigenvalues below the corresponding interval boundary.
The Sturm check is carried out for the given interval limits. From this, the difference is determined.
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4 Results
The results are shown in the tables of the results windows 2.1 through 2.5.

Immediately after the calculation, the 2.1 Design by Load Casewindow appears. The Windows 2.2
through 2.5 show the effective lengths and critical loads as well as the eigenvectors sorted by
certain criteria.

To go to a window, click the corresponding entry in the navigator. To go to the previous or next
input window, use the buttons shown on the left. Alternatively, you can use the function keys to
go the next [F2] or previous [F3] window.

Click [OK] to save the results. Thus you exit RF-STABILITY and return to the main program.

Chapter 4 Results describes the different results windows one by one. Evaluating and checking
results is described in Chapter 5 on page 21.

4.1 Critical Load Factors

The first results window provides information on the critical load factors of the model.

Figure 4.1: Window 2.1 Critical Load Factors

E-Value No.
For each eigenvalue, the table shows the critical load and magnification factors. The result rows
are sorted by numbers of the eigenvectors.

Critical Load Factor f
The table shows the critical load factor for each eigenvalue. If the factor is less than 1.00, this
means that the structural system is unstable. A factor higher than 1.00 means that the loading
from the given axial forces multiplied with this factor results in system failure due to buckling.
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According to [2], clause 5.2.1(3), critical load factors less than 10 for elastic calculations require a
second-order analysis.

If the table output contains a negative critical load factor, no stability failure occurs because of the
tension forces. No conclusion about the expected buckling behavior is possible.

Magnification Factor 𝛼
The magnification factor is determined as follows:

𝛼 = 1
1 − 1/f

(4.1)

The magnification factor describes the relation between the moments according to the geometri-
cally linear static and the second-order analysis.

M II = 𝛼 ⋅ M I (4.2)

where
MI : Moment according to geometrically linear static analysis, but taking into account

the equivalent loading for the deformation

MII : Second-order moment

Equation 4.2, however, applies only if the bending line due to the loading of the eigenvector is
similar, and if the critical load factor f is greater than 1.00.

Message
In column C, a message about a negative critical load factor might appear. This means a reversed
direction of action of the given loading (inverse signs) would result in buckling failure.

You can avoid negative critical load factors by increasing the eigenvectors to be calculated or by
using the ICG iteration method.

At the lower end of the table, the Infinity norm of stiffnessmatrix is given. With this mathematical
norm, you can estimate the magnitude of the highest eigenvalue. This value is important for, e.g.,
the precision of the solution (see [1], Chapter 3, 2.2.3 and Chapter 7).
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4.2 Effective Lengths and Critical Loads

Figure 4.2: Window 2.2 Effective Lengths and Critical Loads

This results window is displayed if the model contains members. You can sort the effective lengths
and critical loads according toMembers or Eigenvectors.

Member No.
The results of the stability analysis are shown for all members of the model. Members subject to
tension forces and failed members are indicated accordingly.

Node No. Start / End
Every member is defined by a start and end node. The numbers are shown in these two columns
A and B, respectively.

Length L
This column shows the geometric length of each member.

E-vector No.
If the table is sorted by members, this column shows you the numbers of eigenvectors.

Effective Length Lcr,y/Lcr,z
The effective length Lcr,y (or Lcr,u) describes the buckling behavior perpendicular to themajormem-
ber y axis (or u for unsymmetric cross-sections). Accordingly, Lcr,z or Lcr,v describe the deflection
perpendicular to the minor member z axis (or v).

The effective lengths Lcr are based on the member-specific critical loads shown in column I. These
loads are relative to the critical load of the total model. This means that the effective lengths need
to be evaluated in the context of the relation of the member axial forces to the total critical load.
For simple cases, the effective lengths are known as the EULER buckling modes 1 through 4.
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In some cases, themost unfavorable critical load of the system can be the critical load of an isolated,
that is, an individual member that is connected by a hinge (see Chapter 8.3, page 38). This can be
seen in the graphic of the corresponding eigenvectors, because a sinusoidal wave is available only
on this member. In this case, the structure shows a so-called local instability. The effective lengths
of all other members cannot be used for this buckling mode. Therefore, they must be taken from
a “higher” eigenvector. The total model fails only there.

Effective Length Factor kcr,y/kcr,z
The effective length factors relating to the local member axes y and z (or u and v) describe the
ratio of effective and member length.

Effective length factor kcr:

kcr = Lcr
L

(4.3)

Critical Load Ncr

This table column shows for eachmember the critical axial forceNcr thatwas determined relative to
the respective eigenvector. Therefore, the individual critical loads and the corresponding effective
lengths must always be seen in the context of the corresponding critical load of the total system.

4.3 Eigenvectors by Node

Figure 4.3: Window 2.3 Eigenvectors by Node

For each eigenvector, the table shows the normalized displacements and rotations of the nodes
in the model. You can sort the window according to Nodes or Eigenvectors.
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Node No.
The eigenvectors are listed for the objects defined in the RFEM Table 1.1 Nodes. Results in the FE
nodes or in the member division points are not shown in the table.

E-vector No.
The deformations are listed for each calculated eigenvector.

Normalized displacements uX / uY / uZ
The displacements listed in columns B through D are relative to the axes of the global coordinate
system. They are normalized to the extreme value 1 of the total displacement or the maximum
given in Window 1.1 General Data (see Figure 2.8, page 11).

Normalized rotations 𝜑X / 𝜑Y / 𝜑Z

The columns E through G list the values of the normalized nodal rotations.

If the table shows only zero values for the normalized displacements of a member model, the
reason is often to be found in large torsions within the members (see the figure below). These
effects do not influence the displacements of the member ends. Therefore, the displayed effective
lengths and critical loads are not very conclusive for these members.

Figure 4.4: Torsion of a thin-walled rectangular column
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4.4 Eigenvectors byMember

This results window is shown only if the model contains members.

Figure 4.5: Window 2.4 Eigenvectors byMember

The columns are described in detail in Chapter 4.3. In addition, the Location x is given for the start
and end node of the corresponding member.

You can sort this window according toMembers or Eigenvectors.
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4.5 Eigenvector by Surface

This Window is shown only if the model contains surfaces.

Figure 4.6: Window 2.5 Eigenvectors by Surface

You can sort the list according to Surfaces or Eigenvectors.

Point No.
The results are shown for each grid point of the surface.

You can control the grid points in RFEM, because user-defined result grids are possible for surfaces.
This function is described in Chapter 8.12 of the RFEM manual. By default, the result grid has a
mesh size of 50 cm.

Location X / Y / Z
The columns B through D (or C through E) indicate the location of the grid points in the global
coordinate system.

Normalized Displacements uX / uY / uZ
The displacements given in the columns F through H refer to the axes of the global coordinate
system. They are normalized to the maximum specified in the 1.1 General Data Window (see
Figure 2.8, page 11).

Normalized Rotations 𝜑X / 𝜑Y / 𝜑Z

The column I through K show the values of the normalized nodal rotations.
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5 Evaluation of Results
You can evaluate the eigenvalue analysis in various ways. To evaluate the results graphically, use
the RFEM work window.

5.1 Results Windows

First you should check the Critical Load Factors given in Window 2.1.

Negative Critical Load Factor

If a negative critical load factor is shown, this means that no buckling failure due to tension forces
could be found. That is, if the load were to act in the opposite direction (inverse signs), the model
would buckle. Negative critical load factors can often be avoided by increasing the eigenvectors
to be determined or using the ICG iteration method.

Critical load factor < 1

Critical load factors less than 1.00 indicate that the system is unstable.

Figure 5.1: Unstable system

Only a positive critical load factor that is higher than 1.00 permits to say that the loading due to
the specified axial forces multiplied with this factor results in the buckling of the stable structural
system.

Effective Lengths

For members, in Window 2.2 the effective length factors kcr are shown for each eigenvector. They
describe the buckling behavior perpendicular to the respective axes.

Figure 5.2: Effective length factors kcr of members

During the analysis, the program increases the axial forces iteratively until the critical load case
occurs. From this critical load factor, RF-STABILITY determines the critical load. In turn, the critical
load allows the determination of the effective lengths and effective length factors.

If you want to show, for example, the governing effective length factor kcr,y for the deflection
perpendicular to the major member y-axis, you normally have to calculate several eigenvectors.
For square sections, you obtain the same effective lengths and effective length factors in both axis
directions.

The effective length factors for continuous members cannot be determined directly by RF-STA-
BILITY. It is only possible to evaluate the results of the individual members. The member with the
lowest critical load Ncr can be considered as governing for the entire set of members. Then, the
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kcr values can be determined from the effective length of this member and the total length of the
set of members.

5.2 Results on the RFEMModel

You can also evaluate the results in the RFEM work window.

RFEM background graphic
The RFEMworkwindow in the background is useful for finding the position of a surface ormember
in the model. The member selected in the results window of RF-STABILITY is marked in the back-
ground graphic with the selection color. Furthermore, an arrow indicates the member x-location
selected in the currently chosen table row. To locate the member, move the RF-STABILITY window.

Figure 5.3: Indication of the member in the current eigenvector of the RFEMmodel

If you cannot improve the display by moving the RF-STABILITY window, click to select the
object graphically. The window is now hidden so that you can select the surface or member by
clicking it. If necessary, you can also change the view. You can use the functions of the Viewmenu,
for example zooming, moving, or rotating the display. The indication arrow remains visible.
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The buttons in the results windows have the following functions:

Button Description Function

Select objects in RFEM graphic
Allows you to graphically select an object
(member, node, surface) to display its results in
the table

Graphic of the current eigenvector
Shows or hides the eigenvector of the current
table row in the RFEM graphic

Color bars
Shows or hides the color reference scales in the
results windows

Excel export
Exports the table to MS Excel / OpenOffice
→ Chapter 7.3, page 31

Table 5.1: Buttons in the results windows 2.1 through 2.5

RFEMwork window
The graphical evaluation of the individual eigenvectors is a good way to evaluate the stability
behavior of themodel: First, click [Graphic] to exit the RF-STABILITYmodule. Now, the eigenvectors
are displayed graphically on the model in the work window of RFEM similar to the deformations
of a load case.

The current RF-STABILITY case is preset. The Results navigator controls which displacements or
rotations are graphically displayed as an Eigenvector.

Figure 5.4: Results navigator for RF-STABILITY

In addition to the total vector u, you can specifically display the displacement and rotation com-
ponents in each of the global directions.

The options Sections and Values on Surfaces can also be used for the graphical evaluation of eigen-
vectors. These functions are described in Chapter 9.6 and 9.4 of the RFEMmanual.

Similar to the display of deformations, the [Show Results] button switches on or off the display of
the eigenvectors. To show or hide the result values in the graphic, click the [Show Values] button
to the right.

You may deactivate the RFEM tables, because they are of no relevance for the evaluation of the
stability analysis.

The panel is adjusted to RF-STABILITY. Chapter 3.4.6 of the RFEMmanual describes the standard
functions in detail.

In the Factors tab of the panel, you can select the eigenvectors.
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Figure 5.5: Selection of eigenvector in the Factors

If the members or surfaces that are prone to buckling are difficult to find, increase the Factor of
the deformation in the Factors tab of the panel. The animation of deformations is also a useful
function. To activate it, click the button shown on the left.

You can control the results display of the members in the Display navigator by selecting Results→
Deformation→Members. By default, the eigenvectors are shown as Lines. The two other options
can also be used to represent the buckling behavior.

Figure 5.6: Display navigator: Results → Deformation → Members → Cross-Sections Colored

You can transfer the graphics of the eigenvectors to the printout report (see Chapter 6.2, page 26).

To return to the add-on module, click [RF-STABILITY] in the panel.
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5.3 Filter for Results

The results windows in RF-STABILITY allow for a selection by various criteria. In addition to this,
you can use the filter options described in the RFEMmanual, Chapter 9.9. The options allow you
to graphically evaluate the results of the stability analysis.

In RF-STABILITY, you can also use the options of the Visibilities (see RFEMmanual, Chapter 9.9.1) to
filter the members in order to evaluate them.

Filtering eigenvectors
The normalized deformations can be used as filter criterion in the RFEM work window. To go to
the RFEM window, click [Graphics]. To apply this filter function, the panel must be displayed. If it is
not, select in the RFEMmenu

View → Control Panel

or use the toolbar button shown on the left.

The panel is described in the RFEM manual, Chapter 3.4.6. You define the filter settings for the
results in the first tab of the panel (Color Spectrum). This tab is not available for the line or cross-sec-
tion display. Therefore, you have to select the Cross-SectionsColored option in theDisplay navigator
(see Figure 5.6).

In the panel you can specify, for example, that only normalized deformations greater than 0.55 are
shown. This option makes it easier to locate the areas prone to buckling.

Filteringmembers and surfaces
In the Filter tab of the control panel, you can specify the numbers of selected members or surfaces
to filter the display of the eigenvectors. This function is described in the RFEMmanual, Chapter
9.9.3. In contrast to the visibility function, the model is displayed, too.

Figure 5.7: Member filter for eigenvectors of a frame beam
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6 Printout

6.1 Printout Report

Like in RFEM, the program generates a printout report for the RF-STABILITY results, to which you
can add graphics and descriptions. In the printout report, you can select which data of the stability
analysis will finally appear in the printout.

The printout report is described in the RFEMmanual. In particular, Chapter 10.1.3.4 Selecting Data
of Add-onModules describes how to select input and output data from add-on modules for the
printout report.

6.2 Graphic Printout

In RFEM, you can add every picture displayed in the work window to the printout report or send
it directly to a printer. In this way, you can also prepare the eigenvectors displayed on the RFEM
model for the printout.

Printing graphics is described in the RFEMmanual, Chapter 10.2.

To print the current eigenvector, click

File → Print

or use the toolbar button shown on the left.

Figure 6.1: Button [Print Graphic] in RFEM toolbar

The result distributions of sections or members can also be transferred to the report or printed
directly by using the [Print] button.

Figure 6.2: Button Print in the toolbar of the results diagram window

The Printout Report dialog box appears (see the following figure).
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Figure 6.3: Dialog box Graphic Printout, tabGeneral

This dialog box is described in the RFEM manual, Chapter 10.2. The manual also describes the
Options and Color Scale tab.

To move a graphic within the printout report, use the drag-and-drop function.

To adjust a graphic in the printout report after the fact, right-click the corresponding entry in the
navigator of the printout report. The Properties option in the context menu return you to the
Graphic Printout dialog box, offering various options for adjustment.

Figure 6.4: Dialog box Graphic Printout, tab Options
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7 General Functions
This chapter describes useful menu functions and export options for the results of the stability
analysis.

7.1 RF-STABILITY Analysis Cases

Analysis cases (or RF-STABILITY cases) allow you to evaluate different aspects of stability. For exam-
ple, you can analyze the influence of the axial force from different load cases or load combinations
with or without the consideration of tensile forces.

To select the analysis cases of RF-STABILITY, you can also use the load case list in the RFEM toolbar.

Creating a new analysis case
To create a new analysis case, select on the RF-STABILITY menu

File → New Case.

The following dialog box appears:

Figure 7.1: Dialog box New RF-STABILITY Case

Enter a Number (one that is still available) for the new RF-STABILITY case. Define an appropriate
Description to make the selection in the load case list easier later on.

Click [OK] to display the RF-STABILITY Window 1.1 General Data, where you can enter the new
calculation parameters.

Renaming an analysis case
To change the description of an analysis case, select on the RF-STABILITY menu

File → Rename Case.

The following dialog box appears:

Figure 7.2: Dialog box Rename RF-STABILITY Case

In this dialog box, you can specify a different Description as well as a different Number for the
analysis case.
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Copying an analysis case
To copy the input data of the current analysis case, select on the RF-STABILITY menu

File → Copy Case.

The following dialog box appears:

Figure 7.3: Dialog box Copy RF-STABILITY Case

Define the No. and, if necessary, a Description for the new case.

Deleting an analysis case
To delete an analysis case, select on the RF-STABILITY menu

File → Delete Case.

The following dialog box appears:

Figure 7.4: Dialog box Delete Cases

You can select the analysis case in the Available Cases list. To delete the selected case, click [OK].
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7.2 Units and Decimal Places

Units and decimal places for RFEM and the add-on modules are managed in one common dialog
box. In the add-on module RF-STABILITY, you can use the menu to define the units.

To open the corresponding dialog box, select

Settings → Units and Decimal Places.

The dialog box known from RFEM appears. RF-STABILITY is preset in the list Program /Module.

Figure 7.5: Dialog box Units and Decimal Places

To reuse the settings in other models, save them as a user-profile. These functions are described
in the RFEMmanual, Chapter 11.1.3.
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7.3 Exporting Results
The results of RF-STABILITY can also be used in other programs.

Clipboard
To copy cells selected in the results windows to the Clipboard, press the keys [Ctrl]+[C]. To insert
the cells, for example in a word processor, press [Ctrl]+[V]. The headers of the table columns are
not transferred.

Printout report
You can print the data of the RF-STABILITY add-on module into the global printout report (see
Chapter 6.1, page 26) to export them subsequently. Then, in the printout report, click

File → Export in RTF.

This function is described in the RFEMmanual, Chapter 10.1.11.

Excel / OpenOffice
RF-STABILITY provides a function for the direct data export to MS Excel, OpenOffice Calc, or the
CSV file format. To open the corresponding dialog box, select on the menu of the module

File → Export Tables.

The following dialog box appears.

Figure 7.6: Dialog box Export - MS Excel

Having selected the relevant options, you can start the export by clicking [OK]. Excel or OpenOffice
are started automatically; that is, you do not need to open the programs beforehand.

Figure 7.7: Results in Excel
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RF-IMP
If you want to use a buckling mode (eigenvector) from RF-STABILITY in the add-on module RF-IMP
to generate equivalent imperfections or a pre-deformed initial model, you do not need to export
the data. RF-IMP allows you to select the relevant eigenvector No. as well as the RF-STABILITY Case
directly in the corresponding lists.

Figure 7.8: Importing the eigenvector in the module RF-IMP

RF-STEEL EC3 / RF-ALUMINIUM / RF-KAPPA / RF-TIMBER Pro
The modules RF-STEEL ISC/AS/BS/CS/EC3/GB/IS/NTC-DF/SANS/SIA/SP, RF-ALUMINIUM, RF-KAPPA,
and RF-TIMBER Pro provide the option to use the effective length factors fromRF-STABILITY directly
for the members that you want to analyze.

Figure 7.9: Selection of effective length factors in the add-on module RF-STEEL EC3
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8 Worked Examples

8.1 Rectangular Plate

Determine the critical buckling load of a square plate with a length of 1 m.

Figure 8.1: FE-model and loading

Analytical solution
This surface is simply supported on all edges. The critical load Ncr can be analytically determined
according to the following equation:

Ncr = k ⋅ 𝜋2 ⋅ E ⋅ ℎ3

12 ⋅ (1 − 𝜈 2) ⋅ a2

For the square plate with a length of 100 cm, you obtain:

k = 4

a = 100 cm

Steel S 235 is used as material.

E = 21.000 kN/cm2

𝜈 = 0.30
The surface has a thickness of 2 cm:

ℎ = 2 cm

For the critical load, you obtain:

Ncr = 4 ⋅ 𝜋2 ⋅ 21,000 ⋅ 23
12 ⋅ (1 − 0.302) ⋅ 1002

= 60.736 kN/cm = 6,037.6 kN/m
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Solution with RFEM
The plate is defined with the following support conditions in RFEM.

Figure 8.2: Line support

In addition, nodal supports with a small spring stiffness are defined for nodes 2 and 3, thus sup-
porting the system in Y-direction.

Figure 8.3: Nodal support

The FE mesh has a size of 5 cm.

A uniform line load of 1,000 kN/m is applied as shown in Figure 8.1.
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Specify the following in RF-STABILITY:

Figure 8.4: RF-STABILITY Window 1.1 General Data

As a result, RF-STABILITY yields a critical load factor of 6.0453.

Figure 8.5: Critical load factor

From the critical load factor and the applied loading, you obtain:

Ncr = 6.0453 ⋅ 1,000 kN/m = 6,045.3 kN/m

Thus, the difference to the analytical solution is about 0.5 %.

RF-STABILITY determines the following eigenvector:

Figure 8.6: RF-STABILITY eigenvector
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8.2 Circular Plate

Determine the critical load of a circular plate with a diameter of 3 m.

Figure 8.7: FE-model and loading

Analytical solution
The surface is simply supported on all edges. The critical load Ncr can be determined by using the
following expression (see [3], p. 559):

Ncr = 14.86 ⋅ E ⋅ ℎ3

12 ⋅ (1 − 𝜈 2) ⋅ a2

The plate has a radius of 150 cm, therefore:

a = 150 cm

Steel S235 is used as material.

E = 21,000 kN/cm2𝜈 = 0.30

The surface has a thickness of 2 cm.

ℎ = 2 cm

For the critical load, you obtain:

Ncr = 14.68 ⋅ 21,000 ⋅ 23
12 ⋅ (1 − 0.302 ⋅ 1502

= 10.038 kN/cm = 1,003.8 kN/m
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Solution with RFEM
The plate in RFEM has a locally defined line support.

Figure 8.8: Line support

The rotation at the edge is thus restrained. Furthermore, theplate is supported in theperpendicular
direction. The support in the line direction x prevents the torsion of the plate about the global
Z-axis.

For the FE mesh, define an element length of 5 cm.

As loading, apply a line load of 100 kN/m corresponding to Figure 8.7.

Specify the following in RF-STABILITY:

Figure 8.9: RF-STABILITY Window 1.1 General Data

As result, RF-STABILITY yields a critical load factor of 10.050.

Figure 8.10: Critical load factor

From the critical load factor and the applied loading, you obtain:
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Ncr = 10.050 ⋅ 100 kN/m = 1,005.0 kN/m

The difference to the analytical solution is thus about 0.1 %.

RF-STABILITY determines the following eigenvector:

Figure 8.11: RF-STABILITY eigenvector

8.3 Tapered Cantilever

This example is from [4]. The paper looks at the buckling modes and the loadings of tapered
T-cantilevers by using experiments and FEM calculations.

In this example, beam 1 from Table 4 is used.

Figure 8.12: FE-model and loading
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The beam has the following dimensions:

Length l 2,800 mm

Web depth hw0 800 mm

Web depth hwl 200 mm

Flange width b 200 mm

Web thickness tw 10 mm

Thickness of flange tf 20 mm

Table 8.1: Beam geometry

The tapered beam has a line load of 1.0 kN/m at the flange.

In [4], the ideal critical load is determined as qcr = 43.6 kN/m.

Solution with RFEM
For the beam, specify the following support conditions at the location of restraint:

Figure 8.13: Restraint of beam

In addition, the end of the beam is laterally restrained.

The FE mesh has a target length of the finite elements of 4 cm.

As loading, a line load of 1 kN/m is applied corresponding to Figure 8.12.
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Specify the following in RF-STABILITY:

Figure 8.14: RF-STABILITY Window 1.1 General Data

As result, RF-STABILITY gives a critical buckling factor of 41.710.

Figure 8.15: Critical load factor

From the critical buckling factor and the applied loading, you obtain:

qcr = 41.710 ⋅ 1.0 = 41.7 kN/m

The difference to the result in [4] is about 4 %.

As governing eigenvector, RF-STABILITY yields the web plate-buckling:

Figure 8.16: RF-STABILITY eigenvector

This result is corresponding to the buckling mode in [4].
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